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Warranty Statement 
All data loggers manufactured by RBR Ltd. since September 2002, are warranted against 
defects in workmanship or original parts and materials for life.  

Units suffering from such defects will be repaired or replaced at the discretion of RBR Ltd., 
provided that the problem has appeared during normal use of the instrument for the 
purpose intended by us. The liability of RBR Ltd. extends only to the replacement cost of 
the instrument. The customer will bear all costs of shipment to us for repair; all other costs, 
including return shipment, will be borne by RBR Ltd.  

This warranty does not cover consumables or normal wear and tear, nor does it cover 
damage caused by negligent use or mishandling. Attempted modification or repair of any 
unit without the prior consent of RBR Ltd. will immediately void any warranty in force. 

Users are expected to maintain a regular program of calibration. Equipment, such as 
sensors made by other companies, is warranted only to the extent provided by the original 
manufacturers.  

We reserve the right to grant or refuse warranty repairs at our discretion if we consider that 
there are reasonable grounds for doing so. 
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Introduction 

Ruskin User Guide 
The Ruskin User Guide introduces you to Ruskin and helps you to use it effectively from the 
start. 

The guide shows you the overall processes that we suggest you use. The process includes 
links to step-by-step procedures that are easy to follow. The guide also provides some 
conceptual information. Because we assume that you will use this guide while you are using 
Ruskin, the guide does not tell you what you can see for yourself in the Ruskin window. 

You can access the Ruskin User Guide on the CD provided when you purchase a logger, 
from the Help menu in Ruskin, and on the RBR web site (www.rbr-global.com).  

Release notes are automatically displayed each time you install an updated version of 
Ruskin. The most recent release notes are also available from the Help menu in Ruskin.  

For information about operating and maintaining the RBR submersible data loggers, see the 
RBR Submersible Logger Hardware section of this manual (p. 44). It will tell you how to 
change the battery, inspect and replace O-rings, and so on. 

Ruskin  
Ruskin is the RBR software that manages your RBR loggers so they provide all the data 
necessary to do your work. Ruskin provides a graphical user interface that makes using the 
loggers easy. Use Ruskin to do the following: 
• configure, schedule and enable multiple loggers 
• download data after logging 
• graphically view data sets 
• export data in various formats 
• change the calibration coefficients for your logger 

Ruskin can be used on Microsoft Windows (XP and Vista), and on the Apple Mac running 
OS X (10.5 Leopard or later).  

Note:  Your logger must be running RBR firmware version 6.2 or later to use this version of 
Ruskin.  That equates to all instruments manufactured after January 1st, 2008. 
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Provide your feedback 
As you use Ruskin to manage your RBR loggers, you may have questions or issues that 
are not addressed in this guide. At such times, we would like to hear from you. 

Steps 
1. From the Help menu, click Comment on Ruskin. 
2. The Feedback to RBR dialog box appears. 
3. Identify yourself and summarize your comments. 
4. Provide a detailed description and add any attachments, if required. 
5. Click OK.  

We will respond to you using the email address that you provide.

 

Installation 
Install Ruskin on a PC 

You can install Ruskin on a Windows computer that uses the XP or Vista operating system.  
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Steps 
1. Place the CD-ROM in the appropriate computer drive. 
2. If the installation does not begin automatically, double-click the executable file 

named Ruskin Complete Setup in the root directory on the CD-ROM. 
3. Follow the installation instructions. You can specify a different name and location for 

the working directory for the software, which is C:\Program Files\RBRRuskin by 
default. 

A shortcut to Ruskin appears on the Desktop and in the Start menu folder called 
“RBRRuskin”.  

Install Ruskin on a Mac 

You can install Ruskin on the Apple Mac running OS X (10.5 Leopard or later). 

Steps 
1. Place the CD-ROM in the appropriate computer drive.  
2. After the CD-ROM mounts, open the drive and double-click the Ruskin package. 
3. Follow the installation instructions. Although you can specify a different folder for the 

working directory for the software, we recommend that you use the default 
Applications folder. 

A folder named “RBRRuskin” appears in the Applications folder. 

Uninstall Ruskin 

If you no longer need to manage RBR loggers from your computer, you can uninstall 
Ruskin. 

Note: The uninstall utility does not delete any Ruskin data files or log files. 

It is not necessary to uninstall an older version of Ruskin before installing a newer version. 
The installation program deletes the older files before installing the newer ones. For more 
information, see  on page 5.  

Windows XP 

On the Control Panel, use the Add/Remove utility and click Ruskin. 
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Windows Vista 

On the Control Panel Home, under Programs, click Uninstall a program, and then click 
Ruskin. 

Macintosh computer 

Move the RBRRuskin folder from Applications to the Trash. 

Update Ruskin 

To take advantage of new features and bug fixes, ensure that you are using the most recent 
version of Ruskin. 

It is not necessary to uninstall an older version of Ruskin before installing a newer version. 
The installation program deletes the older files before installing the newer ones. It does not 
delete any Ruskin data files or log files. 

The most recent version of Ruskin is always available on the RBR web site (www.rbr-
global.com/). However, if you already have an older version of Ruskin installed, Ruskin 
automatically notifies you that a newer version is available when you start Ruskin. If you 
have a broadband connection, we recommend that you follow the installation instructions 
that appear on your computer. Otherwise, request a CD from RBR. 
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Configuration and Scheduling 
Getting started with Ruskin 

Before you begin using your RBR loggers, you may want to experiment a bit with the 
simulated loggers that are included in Ruskin. For more information, see “Stop logging” on 
page 7.

When you are ready to use your own RBR loggers, we recommend that you follow the 
following steps to ensure that you measure exactly what you want on the first attempt. 

You must already have installed the Ruskin on a Windows computer or on a Macintosh 
computer. 

Steps 
1. If you are using your first logger, you can either use the default preferences or 

specify your preferences to apply to all your loggers. For more information, see 
“Preferences” on page 35. You can change these preferences at any time. 

2. Connect your logger locally through your computer’s serial port or USB to serial 
adapter. The logger should appear in the Navigator view after a few seconds. 

3. Click the logger that you want to use. Ensure that it contains the sensors that you 
expect by viewing the Information tab in the Properties view on the right side of the 
Ruskin window. For more information, see “View information about a logger” on 
page 8.  

4. If you want to see live data sampled every few seconds but not saved, select the 
start live plot button in the upper right corner of the Plot view, which is at the bottom 
of the Ruskin window.  

5. Click the Setup/Basic Configuration tab to specify features such as streaming, 
averaging, and thresholding.  
 
Important: You must specify your preferences regarding these features before you 
enable the schedule. For more information, see “Configure a logger” on page 9. 
 

Note: These features are not available for all types of loggers. In fact, much of the 
configuration for the TWR-2050 logger, which records waves, is different from the other 
logger types. For more information, see “Configure a TWR-2050 logger” on page 13. 
 

6. If you want to view or modify calibration coefficients, click the Calibration tab. For 
more information, see “Configure a logger” on page 9. 

 
Important: The conductivity, temperature, and depth sensors were calibrated to 
their specified accuracy before shipment, traceable to NIST standards. We strongly 
recommend that you consult RBR before changing any of these calibration 
coefficients. 
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7. Click the Setup/Schedule tab to schedule the logger to take samples when and as 
often as you want within the limits of your logger. For more information, see 
“Schedule a logger” on page 16.  
 
Ruskin prevents you from enabling a schedule that exceeds the memory capacity of 
the logger. Ruskin also shows the estimated battery usage (based on 1000 mAh 
cells) required to use your logger as scheduled. You should seriously consider this 
information before you enable the schedule. 
 

8. On the Setup tab, click Enable to take samples according to the schedule that you 
specified.  If you enabled streaming data, you can use the live plot mode button in 
the Plot view to choose whether to view samples taken at the default speed for your 
logger type (Fetching mode) or samples taken at the speed that you specified in the 
Sampling period box (Streaming mode) (Properties view/Schedule tab). 
 
Important: If you are streaming data and did not select the Enable data storage 
whilst streaming data check box on the Setup/Basic Configuration tab, the streamed 
data is not stored in the logger memory. 
 

9. If you want to download data, click the Download tab to download all the data saved 
since your schedule was enabled. For more information, see “Download data to a 
file” on page 19. The focus changes to the new dataset in the Navigator view, and 
the static data appears in the Plot view. You can now export the downloaded data to 
a file in Excel, Matlab, engineering text, or raw text formats. You can also save the 
image as a PDF or PNG file for viewing outside Ruskin. 

Stop logging 

Logging stops on its own when one of the following occurs: 
• The end logging time is reached. 
• The power is removed. 
• The logger memory is filled.  
• The logger battery is depleted. 

You can also stop logging at any time by doing the following: 
• On the Setup tab (Properties view), click Stop.  

Important: Whether or not you make any changes to the schedule or the configuration 
before running the schedule again, a warning appears that the contents of memory will be 
erased. If you want to save the data stored so far on the logger, you must download the 
data to a file (Download tab/Download button) before proceeding. 

November 5, 2010  Rev1.4 7



Use a simulated logger 

Ruskin can simulate most logger types that RBR produces. We recommend that you 
experiment with your type of simulated logger before enabling a schedule for your actual 
RBR logger. This practice will probably save you time in the long run. 

Steps 
1. From the Instruments menu, click Simulate instrument. The Configure Simulated 

Instrument dialog box appears.  
2. Under Logger type, click the logger type that you want to simulate. Under Logger 

channels, the types of logger channels on that simulated logger are selected. 
3. If you chose one of the XR logger types, do the following: 

• Under Logger channels, select any additional channels that you want the simulated 
logger to have. 

• If you selected any channels for which the Auto-ranging check box is available, 
consider enabling the Auto-ranging feature. An auto-ranging sensor automatically 
adjusts its gain setting to the best measurement range to display the quantity being 
measured.  

4. Under Options, choose the options that you want for your simulated logger: 
• If you want a visual indication that a logger is running, select the Sampling LED 

check box. 
• If you want to view live the data samples that you schedule, select the Streaming 

check box. 
• If you want the logger to convert raw data to printable ASCII characters in an 

engineering format before transmitting it, select the Engineering units output check 
box. 

5. Click OK. The simulated logger appears under Instruments in the Navigator view. 
6. Click the new simulated logger. You can work with this logger the same way as you 

work with a real RBR logger, including configuring and calibrating it, and logging and 
downloading data. For more information, see “Getting started with Ruskin” on page 
6. 

Multiple loggers, both real and simulated, can be listed in your Navigator view. 

Tip: If you want to remove a simulated logger, right-click it and click Remove simulated 
instrument. You can also use the Instruments menu. 

View information about a logger 

You can view static information about a logger at any time as follows: 
• In the Navigator view, click the logger that you want. The Information tab in the 

Properties view on the right side of the Ruskin window identifies the logger and the kind 
of sensors on its channels. 

Note: This is the only tab in the Properties view that you can access without any battery 
consumption, as indicated by the absence of a battery icon. 
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Configure a logger 

Before you enable a logger schedule, you can configure the logger to suit your 
requirements. 

The instructions to configure a TWR-2050 logger, which measures waves, are different. 

If your logger schedule is already enabled when you decide to change the configuration, 
you must stop running the schedule, make your changes, and enable the schedule again. 
However, any data stored so far on the logger will be lost. 

Tip: You can preserve the data by downloading it to a file before you enable the schedule 
again. 

You can click Revert settings at any time. Note that this action resets the settings on both 
the Setup/Basic Configuration tab and the Setup/Schedule tab to those settings used the 
last time you enabled the schedule for this logger. 

Note: Whenever the Setup tab is in focus, the battery is being used as indicated by the 
battery icon on the tab and the animated battery icon in the Navigator view. You can click 
the Information tab to save power. 

For any XR logger with an external power connector, the logger can be set to start logging 
automatically on power-up. The logger sets the time to 2000/Jan/01 00:00:00 on power-up, 
and starts logging at 2000/Jan/01 00:00:10. The end time is set to 2004/Jan/01 and the 
sampling period that you previously set is used until the power is removed, you stop the 
logger, or the memory is full, assuming data storage was not inhibited. If your logger 
supports this feature, you can activate it by selecting the Enable streaming data check box 
on the Setup/Basic Configuration tab. 

Steps 

1. While the logger you want is highlighted in the Navigator view, click the Setup/Basic 
Configuration tab in the Properties view. 

If any settings are not available for your logger, they are grayed out. 

2. If you want to connect another instrument to the deployed logger to “listen” to the logger 
and take action under certain conditions or while still connected to the logger you want 
to view a graphical display of the live data samples taken according to your schedule, 
select the Enable streaming data check box. We recommend that you also select the 
Enable data storage whilst streaming data check box so that the data will not be lost. 

Note:  Your logger may not support this feature. 

For more information, see “Fetching and streaming data” on page 18. 
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3. If you want your logger to convert raw data to printable ASCII characters in an 
engineering format before transmitting it, select the Enable engineering units output 
check box. 

Note: Although the data stored on the logger is of the highest precision, some precision 
may be lost if you use the data in the Plot view because Ruskin converts the data back 
to the raw format.  

4. If you can see your logger case while it is deployed and want a visual indication that the 
logger is running, select the Enable sampling LED check box. This LED does consume 
battery power. 

The LED will flash when sampling and can be seen through the Delrin© housing. 

Note:  Your logger may not support this feature; this feature is found on XR and XRX 
series loggers. 

5. If you want to use the average of multiple readings rather than take a single reading for 
each sensor in a sampling period, select the Enable averaging check box and specify 
the averaging duration. The averaging duration must be shorter than the sampling 
period. For more information, see “Averaging” on page 11. 

Notes: 1. Your logger may not support this feature. 2. When you use the thresholding 
option, averaging cannot be enabled. 3. Only the averaged value is stored. 

6. If you will be profiling while the logger schedule is enabled, select the Enable 6Hz 
profiling check box. 

Data is collected at six samples per second, and the Sampling period on the Schedule 
tab is disabled. 

Note: Your logger may not support this feature. 

7. If you want to store readings from all your sensors whenever the reading for a particular 
sensor reaches a specific threshold, do the following: 

• Select the Enable thresholding check box. For information about thresholding, 
see “Thresholding and hysteresis” on page 11 

• Click the type of sensor in your logger that you want to monitor. 

• Type the threshold value and indicate whether this is the upper limit (<) or lower 
limit (>) of your threshold.  

• Specify how often you want the monitored sensor to be checked. Checking less 
frequently will preserve battery power because all the sensors on the logger are 
turned off between checks.  
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• If you want to specify a maximum time during which the logger can continue to 
store samples while the thresholding condition is no longer met, select the 
Enable hysteresis check box and specify the time period. Note that Ruskin 
enforces a hysteresis period that is a multiple of your sampling period (Schedule 
tab). For more information, see “Hysteresis” on page 12. 

Notes: 1. Your logger may not support thresholding and hysteresis. 2. When you 
use the thresholding option, averaging cannot be enabled. 

Averaging 

You can enable averaging of sensor readings when configuring a logger (Properties 
view/Setup/Basic Configuration tab or Waves tab). Averaging can give you better statistics 
because although extreme readings are included in the averaged readings, they do not 
attract undeserved attention.  

The averaging duration must be smaller than the value specified for the sampling period 
(Schedule tab). The tidal averaging duration must be smaller than the value specified for the 
tidal sampling period (Setup/Waves tab). These requirements exist because averaging is 
done on all the readings taken during the averaging period, which begins at the start of the 
next sampling period. 

For example, if your sampling period is five seconds and you want to average the readings 
over three seconds, the following happens during each five-second period: 

1. For the first three seconds, readings are taken from each sensor on your logger and at 
the end of the three seconds; the average value is computed and stored for each 
sensor. 

2. For the next two seconds, no readings are taken. 

Thresholding and Hysteresis 

You can enable thresholding when configuring a logger (Properties view/Setup/Basic 
Configuration tab). By thresholding, you avoid storing data when conditions are not of 
interest to you. This option saves the battery and consumes less memory. It is typically 
used when profiling. 

When a specified periodic check by the logger shows that the threshold that you specified is 
reached, the logger starts recording samples at the frequency specified by the sampling 
period (Properties view/Setup/Schedule tab). The logger continues recording samples until 
the threshold is no longer maintained. 

For example, a logger is programmed to check every 10 seconds whether the temperature 
sensor registers less than 20°C and, if so, to take readings from all the sensors every two 
seconds. Here is what happens: 
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Time lapsed 
(seconds) 

Temperature Logger action 

10 20.9°C Reads temperature and then waits 10 seconds 

20 19.8°C Reads temperature and then begins storing all sensor 
values every 2 seconds 

42 20.1°C Reads temperature and then waits 10 seconds 

52 20.5°C Reads temperature and then waits 10 seconds 

Note: When you use the thresholding option, averaging cannot be enabled. 

Hysteresis 

Hysteresis can be enabled only when you also enable thresholding (Properties 
view/Setup/Basic Configuration tab).  The hysteresis option lets you specify the maximum 
time that the logger will continue to store samples while the thresholding condition is no 
longer met. After that time lapses, samples are not stored until the next time the logger 
checks for the thresholding condition and finds that it is met. 

Note that Ruskin enforces an hysteresis period that is a multiple of your sampling period. If 
you change the value of your sampling period, the hysteresis value changes to the same 
value.  

Hysteresis is often used when splashing or wave action is a factor. For example, you 
program your logger to take readings only when it is in contact with the water. You use the 
thresholding option to check every six seconds whether there is contact. Because the wave 
action changes the height of the water surface, the logger fluctuates upon deployment 
between being in and out of the water. By enabling an hysteresis value of ten seconds, your 
logger continues to store samples while not contacting the water for up to ten seconds at a 
time.  
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Time lapsed 
(seconds) 

Water contact Logger action 

1-5 Yes Stores samples because threshold is met 

6-10 No Stores samples due to hysteresis option 

11-13 Yes Stores samples because threshold is met 

14-23 No Stores samples due to hysteresis option 

24 No Checks for threshold and suspends storing samples

25-30 Unknown Waits before checking whether threshold is met 

31 No Checks for threshold 

32-37 Unknown Waits before checking whether threshold is met 

38-60 Yes Resumes storing samples 

 

Configure a tide and wave recording (TWR-2050) logger 

Before you enable a TWR-2050 logger, you can configure it to better suit your 
requirements. This type of logger records data for tides and waves, and its configuration is 
different from that of the other RBR loggers. For information about configuring the other 
loggers, see “Configure a logger” on page 9. 

If your logger is already logging data when you decide to change the configuration, you 
must stop logging, make your changes, and start logging again. However, any data stored 
so far on the logger will be lost. 

Tip: You can preserve the data by downloading it to a file before you restart the logger. 

You can click “Revert settings” at any time. Note that this action will revert the settings on 
any of the Setup sub tabs to those settings used the last time you enabled the schedule for 
this logger. 

Note: Whenever the Setup tab is in focus, the battery is being used as indicated by the 
battery icon on the tab and the animated battery icon in the Navigator view. You can click 
the Information tab to save power. 
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Steps 

1. While the logger you want is highlighted in the Navigator view, click the Setup/Basic 
Configuration tab in the Properties view. 

2. If you want to connect another instrument to the deployed logger to “listen” to the logger 
and take action under certain conditions, or while still connected to the logger you want 
to view a graphical display of the live data samples taken according to your schedule, 
select the Enable streaming data check box. We recommend that you also select the 
Enable data storage whilst streaming check box so that the data will not be lost. 

For more information, see “Fetching and streaming data” on page 18. 

3. If you want your logger to convert raw data to printable ASCII characters in an 
engineering format before transmitting it, select the Enable engineering units output 
check box. 

Note: Although the data stored on the logger is of the highest precision, some precision 
may be lost if you use the data in the Plot view because Ruskin converts the data back 
to the raw format.  

4. If you can see your logger case while it is deployed and want a visual indication that the 
logger is running, select the Enable sampling LED check box. This LED does consume 
battery power. 

The LED will flash when sampling. 

Note:  Your logger may not support this feature. 

5. Under the Setup/Waves tab, in the Tidal sampling period box, specify the interval that 
you want between samples. 

Note: If you change this value, any value in the Wave sampling period box changes 
automatically so that it remains the same number of multiples of this value. For more 
information, see “Relationship between the tidal and wave sampling periods” on page 
15. 

6. If you want to use the average of multiple readings rather than take a single reading for 
each sensor for a tidal sampling period, do the following: 

• Select the Enable tidal averaging check box.  

• Specify the tidal averaging duration. The tidal averaging duration must be shorter 
than the tidal sampling period. For more information, see “Averaging” on page 
11. 

• Specify the rate in Hz at which you want to take tidal samples. 
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Note: If you select the Enable wave measurements check box, this rate also applies 
to the rate at which wave samples are taken. 

7. If you want to take samples of wave bursts, do the following: 

• Select the Enable wave measurements check box. 

• In the Wave sampling period box, specify the interval that you want between 
taking readings of wave bursts. This value must be a multiple of the value 
specified in the Tidal sampling period box. For more information, see 
“Relationship between the tidal and wave sampling periods” on page 15. 

• In the Burst length of the wave box, click the number of samples that you want 
to take during a wave burst. 

• In the Altitude of instrument (m) box, type the number of metres above seabed 
or river bed where the logger will be secured in place. 

This value is used when making wave calculations. 

• Estimate the mean depth of water in metres. 

This value helps predict the range of wave frequencies that can be measured. In 
particular, read-only values for wave analysis bandwidth and wave periods will 
appear. Ruskin will calculate the actual depth from the measured pressure data 
post-deployment. 

You can now schedule your logger. 

Relationship between the tidal and wave sampling periods 

The wave sampling period must be a multiple of the tidal sampling period. Changing the 
wave sampling period changes the relationship between the two values because the wave 
sampling period becomes a different number of multiples of the tidal sampling period. This 
number of multiples is maintained if you then change the tidal sampling period. 

Here is an example that you can try: 

1. If you set the tide sampling period to 5 seconds, then, set the wave sampling period to 
20 seconds (4 multiples of 5). 

2. Now change the wave sampling period to 30 seconds (6 multiples of 5). 

3. Finally, change the tidal sampling period to 10 seconds. 

To maintain the new relationship of 6 multiples, the wave sampling period will change 
automatically to 60 (6 multiples of 10). 
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Note: Within a wave burst measurement the tide can be sampled up to four times.  

Schedule a logger 

You can schedule your loggers to start and stop taking readings when you want and at the 
sampling rate you specify for the sampling period. Ruskin indicates any unattainable 
conditions in the defined schedule at the bottom of the Schedule tab, and the Enable button 
is grayed out. 

You can select Revert settings at any time to set the previous schedule. Note that this 
action reverts back to the settings (on both the Setup/Schedule tab and the Setup/Basic 
Configuration tab) used the last time that you ran the schedule for the logger. 

Before you schedule your logger, you should be satisfied with the global preferences 
(Options menu/Preferences dialog box) and with the configuration settings for your logger 
(Properties view/Setup/Basic Configuration tab or Waves tab). For information, see 
“Configure a logger” on page 9 or “Configure a TWR-2050 logger” on page 13. 

Note: Whenever the Setup/Schedule tab is in focus, the battery is being used as indicated 
by the battery icon on the tab and the animated battery icon in the Navigator view. You 
should display the Information tab to save power. 

Steps 

1. While the logger you want is highlighted in the Navigator view, click the 
Setup/Schedule tab in the Properties view. 

2. Click Synch to PC. 

3. In the Enable boxes, specify the date and time that you want to start running the 
schedule or select the Immediately check box. 

Tip: If you select and then clear the Immediately check box, you can then manually 
modify the current date and time instead of the original values. 

4. Choose whether to specify an end time or to take samples as long as possible: 

• To specify an end time, in the End logging boxes, specify the date and time 
that you want logging to stop. 

• To continue logging as long as possible, click Maximize logging duration. 

The values in the End logging boxes change to the latest date and time 
possible, given the available memory and the specified sampling period. 

5. Choose whether to specify the interval between samples or to take samples as often 
as possible: 
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• To specify the interval that you want between samples, use the Sampling 
period box. 

Note: An error message appears at the bottom of the Schedule tab if the 
sampling period is too fast for your logger.  

• To take readings as often as possible, click Maximize sampling speed. 

The value in the Sampling period box changes to the shortest period possible, 
given the available memory, the specified logging duration, and the minimum 
sampling period for your logger. 

Note: For the TWR-2050 logger, which measures waves, the Sampling period box 
and the Maximize sampling speed button are not available because this kind of 
information is specified on the Setup/Waves tab. 

6. If your logger uses the RS-485 serial protocol, select the Assume RS-485 when 
calculating battery usage check box. 

Because the RS-485 serial protocol draws additional battery power, this information 
is included in the calculations of battery usage. 

7. Note the estimated battery capacity that is required to enable your logger as 
scheduled. Ruskin estimates how long your battery will last using battery capacities 
of 1000 mAh. Actual battery life is affected by your battery capacity and the 
temperature during deployment. 

If the battery bar indicator is orange instead of green, you can still start logging, but 
the logger stops if the battery is depleted before the specified end logging time. 

Tip: If the battery bar indicator is green but shows that you are close to capacity and 
you know that your logger will be operating under very cold conditions, you may 
want to lower the demands on the battery. You can either shorten your logging 
duration or lengthen your sampling period. 

8. Note the actual memory required to use your logger as scheduled. Ruskin prevents 
you from running a schedule that exceeds memory capacity. If your schedule 
requires excessive memory, the memory bar indicator is red rather than green, and 
the Enable button is grayed out.  

Tip: You can either shorten your logging duration or lengthen your sampling period. 

9. Click Enable. 

The schedule runs within 10 seconds. 

Tip: If the Enable button is grayed out, an error message appears. 
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Realtime data 
Fetching and streaming data 

The speed at which a logger takes readings and what it does with those readings depend 
on whether the schedule is enabled and whether streaming data is also enabled. 

Enabled without streaming 

You can enable a schedule without enabling streaming. The logger takes readings as 
scheduled at the speed specified in the Sampling period box. This data is stored and can be 
downloaded. 

If you are still connected to the logger, you can click the start live plot button in the Plot 
view. A graphical display appears of the samples fetched from the logger at the default 
speed for the logger type rather than of the samples that are scheduled and being stored on 
the logger.  

Enabled with streaming 

You can enable a schedule with streaming enabled. The logger takes samples as 
scheduled at the speed specified in the Sampling period box. This data is stored and can be 
downloaded only if you also enabled data storage.  

The streaming option lets you connect another instrument to the deployed logger to “listen” 
to the logger and take action under certain conditions. For example, when a temperature 
reading exceeds 30 degrees Celsius, the connected instrument makes a call to you. 

In the Plot view, if you are still connected to the logger, you can click the live plot mode 
button and select Streaming, and then click the start live plot mode button. A graphical 
display appears of the readings being taken at the speed specified in the Sampling period 
box. However, if any tab other than the Information tab is active, the flow of live data 
pauses until you click the Information tab.    

If you want to view a graphical display of the readings being taken at the default speed for 
your logger type, select the Fetching mode instead of the Streaming mode. 

Not enabled 

When a schedule is not enabled, the logger does nothing by default. However, if you are 
still connected to the logger, you can click the start live plot button in the Plot view. The 
logger immediately begins fetching samples at the default speed for your logger type, and a 
graphical display of the live data appears. The data is not saved on the logger and therefore 
cannot be downloaded. 
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Download 
Download data to a file 

You can download data from a logger at any time. If you stop running a schedule, you must 
download the data before you restart the schedule to prevent the data stored so far from 
being lost. 

Note: Whenever the Download tab is in focus, the battery is being used as indicated by the 
battery icon on the tab and the animated battery icon in the Navigator view. You can click 
the Information tab to save power. 

Steps 

1. If you think that the connection to the logger will be at a low baud rate, perhaps due 
to a long cable, select the Slow Connection check box. Otherwise, Ruskin 
automatically increases the connection speed to the maximum possible during the 
download. 

If the connection speed used is too fast for your environment, the connection may 
fail with a message. 

2. If you want to add notes that will be stored with the downloaded data, add them in 
the Comment box. 

Your comment will be visible on both the Overview and Source tabs (Properties 
view) for the resulting dataset. You can modify or add to this comment on the 
Overview tab. 

3. Click Download. 

The Save as HEX dialog box appears. 

4. Specify a location and a name for the data file. 

By default, the hex file name uses the Ruskin file naming convention. 

The name of the new dataset appears and is highlighted automatically under Datasets in 
the Navigator view. The Properties view changes to the new dataset and contains the 
Overview and Source tabs. All the data that was stored on the logger at the time of the 
download is automatically plotted in the Plot view. 

Note: Downloading data again while the same schedule continues to run picks up the same 
data plus any data stored since the last download. 
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File naming convention 

In Ruskin, by default, the name of a data file is composed of the following information: 

• The first six digits represent the logger serial number. 

• The next eight digits represent the current year, month, and day. 

• The next four digits represent the current time to the minute. 

• The file extension indicates the file format and should not be changed. If you change 
it, the file extension that you specify becomes part of the name, and the required 
extension is appended. 

For example, the file named 911936_20090522_1613.hex contains data for a logger with a 
serial number of 911936 whose data was downloaded in 2009 on May 22 at 4:13 p.m. 

View, analyse, and export 
Open a stored dataset 

You can open any stored dataset to explore its contents. 

Steps 

1. From the File menu, click Open dataset and double-click the hex file that contains 
the data that you want to view, or you can click one of the recently opened datasets 
shown in the menu. 

The name of the dataset appears and is highlighted automatically in the Navigator 
view. The Properties view changes to the dataset. Its Overview tab shows 
information about the logger that generated the data, the schedule that was run, and 
the number of samples represented in the data. The data in the file is automatically 
plotted in the Plot view. 

2. If you want to store a comment with the dataset or modify any comment that you 
added when you downloaded the data, use the Comment box. 

Tip: To close a dataset, right-click its name in the Navigator view and click Close 
dataset. 

The Plot view 

You can use the Plot view to view a graphical display of either static data in datasets or live 
data. When viewing live data, the logger must still be attached. 
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A toolbar at the top of the Plot view contains various buttons to help you customize, explore, 
and export the graphical display. 

Each channel appears as a different colour in the graphical display. These colours are 
specified for all graphical displays in the Plotting section of the Preferences dialog box 
(Options menu/Preferences) and can be changed only there. You can also change other 
defaults affecting the Plot view in the Preferences dialog box. For information, see ”Specify 
plotting preferences” on page 36.

Tabular panel 

You can click a particular time in the plot to view each channel value and related statistics at 
that time. A vertical black line marks the place. The tabular panel on the right shows those 
values, the last value read for each channel, the sample number, and the time that the data 
was read. 

For datasets only, you can select the Display Statistics check box to view the average value 
and standard deviation for each channel based on the number of samples that you specify. 
The number of samples must not be greater than the number of the current sample, which 
appears in the upper-right corner. 

For a TWR-2050 dataset, you can select the Show waves check box to view a plot that 
shows the height of waves. 

If you want to copy the data to the clipboard and then paste it into another application, click 
Copy. Note that the column headings are not included. 

Datasets 

Use the Plot view to view a graphical display of static data in a dataset. 

The graphical display for each dataset appears on its own tab in the Plot view. The dataset 
file name appears at the top of the tab. Note that the icons differentiate at a glance the live 
data from the datasets.  

Tip: If a graphical display does not appear, click the line style button and ensure that either 
Draw lines or Draw markers is selected. 

Live data 

You can use the Plot view to view a graphical display of samples being fetched at the 
default speed for your logger type. If you enabled streaming, you can also view samples 
taken according to your schedule. In either case, the logger must still be attached. For a 
discussion of fetching and streaming, see “Fetching and streaming data” on page 18. 

The graphical display for live data for each logger appears on its own tab in the Plot view. 
The logger model and serial number appear at the top of the tab. Note that the icons 
differentiate at a glance the live data from the datasets.  
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Tip: If a graphical display does not appear, click the start or resume live plot button. If the 
graphical display still does not appear, click the line style button and ensure that either Draw 
lines or Draw markers is selected. 

Zoom tools for datasets and live data 

Purpose Button How to use 

Compress 
or expand 
data 
horizontally 

Horizontal zoom out

Horizontal zoom in 

Click the button each time you want to further 
compress or expand the data horizontally. The 
expansion or contraction is centered around the 
vertical black line in the plot. If no line exists, the focus 
is in the centre. 

Tip: To place or move a vertical black line, click the 
time in the plot on which you want to focus. 

Compress 
or expand 
data 
vertically 

Vertical zoom out  
Vertical zoom in 

Click the button each time you want to further 
compress or expand the data vertically. 

Undo the 
last zoom 

Undo zoom Click the button to undo the last zoom in or out. You 
can do this as many times as you zoomed.  

Return to 
the original 
view 

Reset zoom Click the button to return to the original view of the 
graphical display. 
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Other tools for datasets and live data 

Purpose Button How to use 

Show or 
hide a 
legend in 
the plot 

Show legend/Hide 
legend 

Click this button to toggle between showing and hiding 
a legend at the bottom of the plot.  

Save an 
image of the 
graphical 
display to a 
file 

Export plot Click the button and then specify a file type (PDF or 
PNG), location, and name for the file that will contain 
an image of the graphical display currently in the Plot 
view. For more information, see “Save a plot for 
viewing outside Ruskin”  

Tip: If you want the legend to be included, first click 
the show legend button. 

Show lines 
or markers 
for each 
channel 

Line style  Click the button and then click Draw lines, Draw 
markers, or both. If you click neither, no graphical 
display appears in the Plot view.  

Show or 
hide 
particular 
channels or 
raw data 

Show/hide 
channels 

Click the button and select which channels to show in 
the Plot view. You can choose to show or hide specific 
channels used by your logger, or all the channels of a 
particular type, such as measured, derived, depth, or 
temperature. 

Tip: If you want to view the uncalibrated data for 
measured channels in the form of a voltage ratio 
instead of as engineering units, select Toggle raw 
channels. 

Show 
events and 
errors in the 
graphical 
display 

Display any dataset 
events or errors  

If the icon on the button is yellow, click the button and 
select Display dataset events or Display dataset 
errors or both. A green icon indicates no events. 
Refer to appendix C for a description of the events 
and errors. Dataset events appear on the x-axis as a 
vertical gray line with a stamp to indicate the type of 
event, such as STP for a stop event in a dataset.  

Show or 
hide axes 

Show/hide axes Click the button to toggle between showing and hiding 
the vertical axes to the left of the plot. 
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Show or 
hide data 
panel 

Show/hide data 
panel 

Click the button to toggle between showing and hiding 
the data panel to the right of the plot. 

Minimize the 
Plot view 

Minimize Click the button to place the Plot view as an unopened 
view in the margin of the Ruskin window. 

Tip: To restore the Plot view to its former size, click 
the restore button in the margin. 

Maximize 
the Plot view 

 Maximize Click the button to expand the Plot view to the full size 
of the Ruskin window. 

Tip: To restore the Plot view to its former size, click 
the Restore button in any margin that contains an 
unopened view. 

Tools only for datasets 

Purpose Button How to use 

Place the 
depth 
channel on 
the y-axis 

Depth plot Click the button to reorganize the graphical display so 
that the depth channel becomes the vertical, or y-axis, 
and all other channels are plotted along the horizontal, 
or x-axis. 

Tip: Click the maximize button to more easily view the 
graphical display. 

Tools only for live data 

Purpose Button How to use 

Toggle 
between 
fetching 
samples at 
the default 
speed and 
viewing 
streamed 
data  

Live plot mode Click the button and then click Streaming or 
Fetching. You can select the streaming mode only if 
you are currently logging data and you selected 
Enable streaming data (Properties view/Setup/Basic 
Configuration tab or Waves tab). 

Note: If any tab other than the Information tab is active 
in the Properties view, any streamed data flow is 
suspended. 

 Tip: When switching from one live plot mode to the 
other, first click the suspend live plot button then 
choose the other live plot mode, and finally click the 
resume live plot button.  
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Start, stop, 
or restart the 
flow of data 
in the Plot 
view 

Start live 
plot/Suspend live 
plot/Resume live 
plot 

Click the button to start, stop, or restart the flow of 
data in the Plot view. If you click the Suspend live 
plot button, the graphical display is frozen. If you click 
the Resume live plot button, the flow of current data 
resumes.  

Note: In the Plot view, data is not recorded during the 
time that the live plot is suspended. However, data 
continues to be stored on the logger as scheduled. 

Delete the 
data in the 
Plot view 

 Clear plot Click the button if you want to delete all the data in the 
Plot view for all channels. 

Note: Any data stored on the logger is preserved.  

 

Tide and Wave Display 

When data has been downloaded from a TWR-2050P recorder that contains wave 
information, three derived units are always calculated: depth, significant wave height 
(WavHt) (which corresponds to H1/3 in meters), and tidal slope (TSlope) (m/hour).  These 
parameters can be seen graphically in the Plot view, while clicking on the Waves tab to the 
right of the Plot view will show a summary of the derived units.  Selecting a particular wave 
burst on the main plot display will show the calculated parameters for that burst in the Wave 
tab. 
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Export data  

You may want to share your data with others or analyze your data using other software. 
You can export data as a text file, which can then be imported into many applications, or for 
analysis in Microsoft Excel or The MathWorks Matlab. 

You must already have downloaded the data to a dataset or opened an existing dataset. 

Steps 

1. Right-click the dataset whose data you want to export, and click Export as, or use 
the File menu. 

2. Choose the type of file that you want to create: 

• To work with your data in Excel or Matlab, click the respective name. 

• To work with your data in a text file, click Engineering text txt.  

• To work with your raw data in a text file, click Raw text txt. 

• To work with your wave information from a TWR-2050 in a text file, click TWR 
wave. 
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• To work with your tide information from a TWR-2050, click TWR tide.  

3. Specify a location and a name for the data file. 

By default, the file name is that of the dataset with the appropriate file extension. 

4. Click Save. 

 

Save a plot for viewing outside Ruskin  

You may want to share a plot with others, include its image in a document, or print it. 

Steps 

1. In the Navigator view, click the dataset or logger whose plot you want to save. 

2. In the Plot view, click the export plot button and specify a file type (PDF or PNG) for 
the file that will contain an image of the graphical display currently in the Plot view.  

3. Specify a location and a name for the plot. 

By default, the location is the one specified in the Directory for data files box 
(Options menu/Preferences dialog box/General). You can change the location for 
this file, which will also change the default location. 

By default, the file name for a dataset plot is that of the dataset with the appropriate 
file extension. The default file name for a plot showing live data follows the Ruskin 
file naming convention. 

4. Click Save. 

Calibration 
Change calibration coefficients 

You can view the calibration coefficients that were entered when your logger was last 
calibrated. You can change these calibration coefficients by typing directly into the table 
cells or by pasting a row or table of coefficients from an external source, such as a 
spreadsheet. 

Note: Whenever the Calibration tab is in focus, the battery is being used as indicated by the 
battery icon on the tab and the animated battery icon in the Navigator view. You can click 
the Information tab to save power. 

November 5, 2010  Rev1.4 27



Important: The conductivity, temperature, and depth sensors were calibrated to their 
specified accuracy before shipment, traceable to NIST standards. We strongly recommend 
that you consult RBR before changing any of these calibration coefficients. 

Steps 

1. While the logger you want is highlighted in the Navigator view, click the Calibration 
tab in the Properties view. 

The current values for the coefficients appear. 

Tip: To view the previous set of coefficient values for the logger, scroll to the bottom 
of the Calibration tab and click Retrieve previous episode. To view all previous 
sets of coefficient values, click Retrieve all episodes. You may want to click the 
maximize button **show button**for the Properties view. 

2. Choose how you want to make your changes. 

Goal Action 

To change calibration coefficients directly in 
Ruskin 

Click each value once, type a different value, 
and press Enter. 

To copy out an entire row or the entire table 

Note: Individual columns of data cannot be 
copied. 

If copying a single row, highlight the row in the 
table and then click Copy from selected row. 

If copying the entire table, click Copy table.  

To paste data for an entire row or the entire 
table 

If pasting a single row, highlight the row 
whose data you are changing and then click 
Paste to selected row. 

If pasting an entire table, click Paste table. 

Tip: Until you store the calibration values, you can restore the original coefficient values 
in the table at any time by clicking Revert calibration. 

3. After you finish making all the changes that you want, click Store calibration to write 
the coefficients into the logger memory. 

N-Point Calibration 

RBR data loggers use several types of sensors that generate a voltage output that is 
proportional to the value of the parameter being measured.  Ruskin will allow N-point 
calibration of these sensors, specifically dissolved oxygen measured by an Oxyguard 
sensor, pH, turbidity and depth in a TGR-1050HT.    Ruskin can be used to easily generate 
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the appropriate calibration coefficients based on the data generated during calibration 
measurements.   

Oxyguard DO Calibration 

The Oxyguard DO sensor has relatively stable performance, and it can be calibrated with a 
single-point calibration technique using a reading at 100% oxygen concentration only.  The 
100% calibration should be performed at the expected temperature and salinity of the 
deployment environment. 

Equipment 
1. Large mouth beaker with a volume of not less than 2 litres 
2. Aquarium air pump 
3. Magnetic stirrer 
 
 

Steps 

1. Program the logger to sample at a fairly fast rate (between 6Hz and 3 seconds).  Use 
Sync to PC to ensure the logger clock is synchronized to the PC clock, and ensure the 
end time is set so that the logger will keep sampling until calibration is complete. 

2. Fill the beaker with water and install the magnetic stirrer, ensuring that the stirrer is 
turned on.  Bubble air through the water using the air pump. 

3. Submerge the dissolved oxygen sensor near the stirrer to ensure that it is in a well-
mixed area of the bath. 

4. Take sample readings for at least 15 minutes for the 100% calibration point, making 
note of the time that the sample is being measured. 

5. Retrieve the data from the data logger as per the steps in the “Download” section on 
page 19 of this manual. Make sure that a copy of the data is saved as well. 

6. The calibration data should now be displayed in the Plot view.  Click the Calibration tab 
in the Properties view to the right of the Plot view.  
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7. Select the dissolved oxygen sensor type from the drop-down menu.  If the data logger 
has multiple sensors, the Plot view will automatically update to only show the channel 
being calibrated.  For the dissolved oxygen sensor, the 1 point calibration option should 
be selected. 

8. The Number of Samples field is automatically set to 100 samples.  This value is the 
number of sample points Ruskin will use to calculate the calibration coefficients for the 
sensor.  Typically, this value will be in the range of 50 to 100 samples. 

9. Click on a stable point in the Plot view corresponding to 100% oxygen.  The Calibration 
tab will now show the average value and standard deviation for the range of samples set 
in Step 7. 

10. Click in the Real Avg field in the Calibration tab and select the value 100 (for 100% 
oxygen) from the drop-down menu.  Ruskin will automatically calculate the calibration 
coefficients, and the values will appear in the four boxes at the bottom on the Calibration 
view. Clicking the Copy button will save the new calibration coefficients to the clipboard. 

11. Follow the steps in Change calibration coefficients on page 27 to update the calibration 
in the data logger. 

 

AMT pH Calibration 

Calibration of the pH sensor should use two or more pH buffers, and should be carried out every 
day that the electrode is used for optimum accuracy.  It is recommended that a pH 7 buffer be 
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used to check the zero point and an acid and an alkaline buffer used to set the slope.  RBR 
uses pH 4 and pH 10 to measure the slope. 

Steps 

1. Program the logger to sample at a fairly fast rate (between 6Hz and 3 seconds).  Use 
Sync to PC to ensure the logger clock is synchronized to the PC clock, and ensure the 
end time is set so that the logger will keep sampling until calibration is complete. 

2. Place the probe into buffer solutions of values 4, 7 and 10 for approximately 10 minutes 
in each solution. Remember to make note of the time for each of the sample points so 
that the correct data can be used to determine the calibration coefficients. 

Note: Ensure that the pH sensor is rinsed with clean water between each sample 
reading to avoid contamination between buffer values. 

3. Retrieve the data from the data logger as per the steps in the “Download” section on 
page 19 of this manual. Make sure that a copy of the data is saved as well. 

4. The calibration data should now be displayed in the Plot view.  Click the Calibration tab 
in the Properties view to the right of the Plot view.  

5. Select the pH sensor type from the drop-down menu.  If the data logger has multiple 
sensors, the Plot view will automatically update to only show the channel being 
calibrated.   

6. The Number of Samples field is automatically set to 100 samples.  This value is the 
number of sample points Ruskin will use to calculate the calibration coefficients for the 
sensor.  For the pH sensor, this value will typically be 25 samples. 

7. To set the first point in the slope measurement, click on a stable point in the Plot view 
towards the end of the measurement in the pH 4 solution.  The Calibration tab will now 
show the average value and standard deviation for this data point. Then click on the 
Real Avg box and enter the actual value of the buffer, in this case 4. 

8. Repeat Step 7 for the pH 7 and pH 10 points, ensuring that you first select the next line 
in the calibration tab for the calibration point. 
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9. Ruskin will automatically calculate the calibration coefficients, and the values will appear 
in the four boxes at the bottom on the Calibration view. Clicking the Copy button will 
save the new calibration coefficients to the clipboard. 

10. Follow the steps in Change calibration coefficients on page 27 to update the calibration 
in the data logger. 

 

Seapoint Turbidity Calibration 

The Seapoint turbidity sensor is calibrated with a two-point calibration technique. The 
calibration should be performed under fluorescent lighting. 

Equipment 
1. 4000-FTU Formazin standard – 100ml 
2. Distilled water – 8 litres 
3. Black-walled, wide-mouth container (I.D.min=300mm, Heightmin=200mm) 
4. Volumetric flask 1000ml, class A 
5. Volumetric flask 100ml, class A 
6. Stir stick 

Steps 

1. Program the datalogger to sample using a 10 second sampling interval.  Use Sync to 
PC to ensure the logger clock is synchronized to the PC clock, and ensure the end time 
is set so that the logger will keep sampling until calibration is complete. 

2. Flush the sensor, container and glassware with distilled water and dry them. 

3. Fill the black wall container with 8000ml distilled water using the large volumetric flask. 

4. Set the sensor in the container until the sensor is fully submerged in the distilled water.  

Note: The distance from the sensor’s windows to the container wall must be at least 20 cm. 
If possible, place a dark cover on the calibration container and avoid direct light on the 
container. 

5. Record the data in distilled water for 5 min. This is the zero-turbidity calibration point. 

6. Fill the 100ml volumetric flask with Formazin Standard. Remember to gently shake the 
bottle before opening the Formazin solution. 

7. Add 100ml Formazin Standard to the black wall container with distilled water, and gently 
mix solution with a stirring stick. 

November 5, 2010  Rev1.4 32



8. Calculate value of the standard turbidity solution at calibration point according to 
following formula: 

                    TuSTD = TuSTK*VTOT/(VDW+VTOT) = 49.38 FTU 

        Where: 

         TuSTD = turbidity of the standard solution (FTU) 

         TuSTK = 4000FTU – turbidity of the stock solution 

         VTOT = 100 ml volume of stock solution at calibration point (ml) 

         VDW = 8000ml - initial volume of distilled water 

Note: By using this formula and changing the volume of distilled water and Formazin 
solution, you can prepare different calibration points for checking linearity of the turbidity 
sensor or getting close to real turbidity value of standard turbidity solution. 

9. After 5 minutes, remove the logger from the calibration container and wash the sensor 
head under regular tap water. 

10. Retrieve the data from the data logger as per the steps in the “Download” section on 
page 19 of this manual. Make sure that a copy of the data is saved as well. 

11. The calibration data should now be displayed in the Plot view.  Click the Calibration tab 
in the Properties view to the right of the Plot view. 

12. Select the Tu sensor type from the drop-down menu.  If the data logger has multiple 
sensors, the Plot view will automatically update to only show the channel being 
calibrated.   

13. For the turbidity sensor, the Number of Samples field should be set to 25 samples. 

14. Click on a stable point in the Plot view corresponding to the zero-turbidity calibration 
point.  

15. Click in the Real Avg field in the Calibration tab and enter the value 0. 

16. Repeat steps 14 and 15 for the Formazin solution readings, entering the value 
calculated in step 8 for the Real Avg field. 

17. Follow the steps in Change calibration coefficients on page 27 to update the calibration 
in the data logger. 
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HT Druck Pressure Sensor Calibration 

The TGR-1050HT and TWR-2050HT both use an atmospheric compensated Druck 
pressure sensor that can be calibrated by the end user using a two-point calibration 
method.  Please note that this procedure is only for HT units, and does not apply to the 
pressure sensor used in the single and multi-channel data logger instruments. 

Steps 

1. Program the datalogger to sample using a 10 second sampling interval.  Use Sync to 
PC to ensure the logger clock is synchronized to the PC clock, and ensure the end time 
is set so that the logger will keep sampling until calibration is complete. 

2. Hold the depth sensor out of the water for a period of approximately 5 minutes.  This will 
be the zero depth point for the calibration. 

3. Immerse the depth sensor to a known depth for 5 minutes.   This set of readings will be 
the “at-depth” value. 

4. Retrieve the data from the data logger as per the steps in the “Download” section on 
page 19 of this manual. Make sure that a copy of the data is saved as well. 

5. The calibration data should now be displayed in the Plot view.  Click the Calibration tab 
in the Properties view to the right of the Plot view.  

6. Select the Depth sensor type from the drop-down menu. 

6.  

7. The Number of Samples field is automatically set to 100 samples.  This value is the 
number of sample points Ruskin will use to calculate the calibration coefficients for the 
sensor.  For the depth sensor, this value should be set to 20 to 25 samples. 

8. To set the first point for the two-point calibration, click on a stable point in the Plot view 
corresponding to your zero depth point from step 2..  The Calibration tab will now show 
the average value and standard deviation for this data point. Then click on the Real Avg 
box and enter the value 0. 

9. Repeat step 8 for your “at-depth” value, entering the known depth range into the Real 
Avg box. 
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10. Follow the steps in Change calibration coefficients on page 27 to update the calibration 
in the data logger. 

Alec Rinko Optode Calibration 

The Rinko Optode cannot be calibrated using Ruskin N-point calibration.  The required 
calibration procedure is documented in the application note “User Calibration for RINKO 
oxygen sensor” in Appendix C of this manual.  Once the calibration is complete and the new 
coefficients for G and H have been calibrated, you will need to upload these values into 
your data logger using the Ruskin software.  

Steps 

1. With the logger connected to your computer and Ruskin open, click on the Calibration 
tab in the Properties view. 

2. You will notice that the calibration coefficients in the table are in the form of C1, C2, C3, 
etc.  The calibration application note from Rinko uses A, B, C…H as the coefficient 
references.  The calculated coefficient for G will be entered into the table under C7, 
while H will be entered under C8. 

3. Please note that you should not modify any of the other coefficients for the Rinko (i.e. 
C1 to C6). 

4. Follow the steps in Change calibration coefficients on page 27 to update the calibration 
in the data logger. 
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Preferences 
Ruskin sets global preferences that require no changes in many situations. However, as 
you learn more about what Ruskin can do, you may want to change some of these defaults 
to better suit your requirements. The global preferences include 

• where to store output files 
• plotting preferences 
• adding depth as a derived channel 
• adding derived channels related to conductivity 
• adding dissolved oxygen as a derived channel 
• calculating derived channels when sensors are missing 

You can change these preferences at any time. 

Specify directories for log files 

You can control where log files are stored by default. Specify these locations before 
downloading any data. 

Steps 

1. From the Options menu, click Preferences. 
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2. In the list on the left side of the Preferences dialog box, click General. 

3. In the Directory for log files box, type a directory name or click Browse to locate the 
directory where you want to store log files. 

Note: Log files are used when you request RBR support. 

4. Click Apply or OK. 

You can change where future log files are stored by default at any time. The change takes 
effect immediately.  

Specify plotting preferences 

You can specify how you want the graphical display in the Plot view to behave by default. 
With the exception of choosing colours for each channel, these preferences can be 
overridden for a particular graphical display in the Plot view. 

Tip: You can click Apply to save your changes without closing the dialog box. 

Steps 

1. From the Options menu, click Preferences. 

2. In the list on the left side of the Preferences dialog box, click Plotting. 

3. Specify whether you want to hide by default any measured channels that are used 
only to create derived channels. 

For example, you may want to hide the pressure channel used to determine depth. 
Viewing both sets of values adds nothing because they are mirror images of each 
other. Hiding this pressure channel in a plot does not also hide a pressure channel 
used to measure pressure for its own sake. 

4. Specify whether you want to show events by default in the Plot view. 

Events appear at the x-axis as a vertical gray line with brief text to indicate the type 
of event, such as STP for a stop event in a dataset.  Refer to appendix  C for a list of 
the event types. 

5. Specify whether you want to show errors by default in the Plot view. 

6. Click each channel number and specify the colour that you want it to be in the Plot 
view. Choose a selection of colours that are easy to see and differentiate. 

7. Click OK. 
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Derived channels 

Derived channels contain calculated data based on data from measured channels. In the 
Derived Channels section of the Preferences dialog box, you can choose additional 
channels derived from measured channels. You can also set the salinity, pressure, and 
temperature values used to calculate the derived channels when a sensor is not available. 

Derived channels are included by default in the Plot view and in datasets. 

Add depth as a derived channel 

If your logger has a pressure channel, you can use its measurements to derive a depth 
channel. The data calculated for this derived channel appears along with measured 
channels in the Plot view and in datasets. 

Steps 

1. From the Options menu, click Preferences. 

2. In the list on the left side of the Preferences dialog box, click Derived Channels. 

3. On the Depth tab, select the Enable Depth Channel check box. 

4. In the Atmospheric Pressure box, type a deciBar value for the atmospheric 
pressure on the logger or use the default value. 

This value corrects the pressure measurements during the depth calculation. 

5. Click either Simplified calculation or Seawater calculation, which is a calculation 
based on a UNESCO technical paper: 

• If you want to use the simplified calculation, type the actual water density or 
use the default value. Note that for freshwater, the density should be set to 
1.0.  

• If you want to use the UNESCO seawater calculation, specify the latitude of 
the data collection in degrees and minutes. 

Add derived channels related to conductivity 

If your logger has a conductivity channel, you can use its measurements to derive channels 
for salinity and speed of sound. The data calculated for these derived channels appears 
along with measured channels in the Plot view and in datasets. 

Steps 

1. From the Options menu, click Preferences. 
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2. In the list on the left side of the Preferences dialog box, click Derived Channels. 

3. Click the Conductivity – Salinity tab. 

If you want to apply a correction to the raw conductivity measurements for temperature and 
pressure changes, do the following: 

• Select the Use conductivity correction check box. 

• Type a value for hydrostatic pressure or use the default value for use when 
no pressure sensor is available. 

• Ruskin uses the following equation: 

 (1+ a(T-Tc) + cP) 

 conductivity 

Cm is the measured conductivity 

T is the temperature  

P is the hydrostatic pressure 

a, b, Tc and c are experimentally determined constants and are labeled in 
Ruskin as C1, C2 , C3 and C4 respectively.   

a is a function of the coefficient of linear expansion of the ceramic centre of 
the conductivity sensor 

b is a function of the zero drift of the conductivity sensor as a function of 
temperature 

Tc is the principal calibration temperature of the conductivity sensor 

c is a coefficient which defines the pressure sensitivity of the conductivity 
sensor 

4. If you want to derive a salinity channel using any XR-420/620-CT/CTD logger, select 
the Density anomaly (kg/m3) check box. 

Ruskin applies a correction to the density measurements that is calculated based on 
the UNESCO Technical Paper in Marine Science #44. 

5. If you want to derive the specific conductivity for any XR-420/620-CT/CTD logger, 
under Specific Conductivity, select the Corrected at 25°C check box. 

Ccorr = (Cm – b(T-Tc)) /

Where Ccor is the corrected
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Ruskin calculates the Specific Conductivity from Standard Methods for the 
Examination of Water and Wastewater (1989) Ch. 2, L. S. Clesceri et al Eds., 
American Public Health Association, Washington D.C., 17th Ed.  

6. If you want to calculate salinity using any XR-420/620-CT/CTD logger, under 
Salinity, select the Practical Salinity Scale check box. 

7. If you want to calculate the speed of sound using any XR-420/620-CT/CTD logger, 
under Speed of Sound, select the formula that you want to use, one of UNESCO, del 
Grosso, or Wilson.   

Add dissolved oxygen as a derived channel 

You can derive a dissolved oxygen channel that measures the oxygen saturation as a 
percentage. The data calculated for this derived channel appears along with measured 
channels in the Plot view and in datasets. 

Steps 

1. From the Options menu, click Preferences. 

2. In the list on the left side of the Preferences dialog box, click Derived Channels. 

3. Click the Dissolved O2 tab and select the Enable Dissolved Oxygen Channel 
check box. 

4. If any of your loggers use the Oxyguard DO sensor to measure oxygen saturation 
and you want to use the Weiss equation, select the Calculate concentration using 
the Weiss equation check box and select the output unit, one of µMol/l, mg/l or ml/l.  

The Weiss equation requires values for temperature and salinity. If your logger does 
not measure these things, you can specify standard values on the No sensor values 
tab. 

5. If any of your loggers use the Aanderaa Optode DO sensor to measure oxygen 
concentration, select the Calculate concentration check box and select the output 
unit, either mg/l or ml/l. 

6. If any of your loggers use the Aanderaa Optode DO sensor to measure oxygen 
saturation, select the Calculate saturation using the Garcia and Gordon equation 
check box. 

The Garcia and Gordon equation requires values for temperature and salinity. If your 
logger does not measure these things, you can specify standard values on the No 
sensor values tab. 
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Calculate derived channels when sensors are missing 

When your sensors do not provide the salinity, pressure, or temperature values needed to 
calculate derived channels, you can specify actual values to use instead. 

Steps 

1. From the Options menu, click Preferences. 

2. In the list on the left side of the Preferences dialog box, click Derived Channels. 

3. Click the No sensor values tab. 

4. In the boxes provided, specify the values that you want to use when actual values are 
not provided by your sensors. 

 

Generic Serial Card - Meta table 
 
More complex sensors that use serial interfaces are integrated in the logger through an 
RBR generic serial card. Each serial card must be configured for the particular sensor 
using a meta table. Meta tables are set at RBR Ltd. before delivery. However, it may be 
necessary to change the meta table in the field and this tab allows the meta table to be 
viewed, edited and sent to the generic serial card. 
 
Ruskin detects whether logger is equipped with one or more serial cards and displays 
the Generic Serial tab in the Editor View.  If the Generic Serial tab does not appear, it 
means that there is no serial card present. 
 
The Generic Serial tab is divided into three areas: Meta Table, Test Meta table-Sample 
data and the Editor.   
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Meta Table 
 

Channel number 
If there is more than one serial card in the logger you can select the appropriate card by 
selecting the correct channel number from the drop down list. 

Get table from interface 
Pressing this button retrieves the current meta table stored in the card and displays it in 
the Editor area. 

Configure sensor 
Pressing this button loads the configuration in the meta table into the sensor. 
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Test Meta Table – Sample data 
 

Get data from sensor 
Pressing this button sends a command to all sensors asking them to perform a reading 
immediately.  The resulting data is displayed in the Editor area.  
 

Editor Area 
 
In the editor area the meta table is displayed and can be edited.  Messages are 
displayed from the application in a status box under the editor which indicate the 
success or failure of reading and writing meta tables. 
 

Open table file 
Pressing this button opens a browser that allows you to select the appropriate meta 
table file to display in the Editor area. 
 

Send table to interface card 
Pressing this button sends everything that is in the View and Edit area to the serial card 
(channel number) selected.  Be careful when sending meta tables to the card to ensure 
you do not send unintended information to the card.  To ensure that only the correct 
meta table is sent, press the clear editor button and open the table file again. The meta 
table is sent to the serial interface card and the sensor is configured at this time.  
 

Save table to file 
Pressing this button displays a browser which allows you to name and save all the data 
in the Editor area.  If you want to save the meta table in the selected serial card, press 
clear editor, select get table from interface and then save table to file. 
 

Clear editor 
Pressing this button removes all the data from the Editor area. 
 
Note: There is no capability to perform a live plot for loggers with a generic serial card. 
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Logger Hardware 

Basic operating instructions 

Introduction  
This section of the manual covers the basic operation of RBR’s submersible data loggers: 
changing the battery, inspecting and replacing O-rings, etc.  Please see the Ruskin User 
Guide section of this manual for instructions relating to logger programming and data 
retrieval.  This manual can also be found on the distribution CD and on RBR’s website 
(www.rbr-global.com). 

Opening and closing the logger  

 

 

1050 and 2050 series loggers 

To open the TR-1050, DR-1050 or any of the 2050 family of loggers, 
unscrew the sensor end counter-clockwise. The end cap does not 
unscrew completely until the O-ring is clear of its mating surface in the 
body. This ensures that it will not eject at high speed should the 
interior of the logger become pressurised. 

Carefully draw the end cap away from the body, sliding the attached 
inner assembly out of the case.  

XR loggers 

XR series loggers have two end caps: the sensor end cap houses the 
sensors, and the battery end cap covers the data port and battery 
carousel.  Plastic loggers have a 6mm mooring line hole through the 
battery end cap.  Titanium versions have a larger mooring line hole 
through a cylindrical protrusion out of the battery end cap.   

Access to the data port and the battery carousel is gained by removing 
the end cap opposite the sensor end of the logger. It may be 
unscrewed by hand or by using a rod inserted into the mooring line 
hole for leverage. The end cap does not unscrew completely until the 
O-ring is clear of its mating surface in the body. This ensures that it will 
not eject at high speed should the interior of the logger become 
pressurized. 

Note:  Do not touch the circuit boards; moisture or even fingerprints can 
affect the accuracy of the logger.  The exposed logger should be held by its 
sides. 
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The battery carousel is fastened to the assembly by a bolt through its 
centre. The carousel may be removed by twisting the bolt counter-
clockwise until it is free. 

Access to the inner assembly may be obtained by unscrewing the 
sensor end cap.  Both the battery end cap and the battery carousel 
must be removed prior to unscrewing the sensor end cap. Damage to 
the back plane will result if the wrong end of the logger is opened first.   

Closing the logger is exactly the reverse of opening it. Remember to keep the O-rings clean and 
avoid scratching the O-ring mating surfaces. Carefully inspect the O-rings, as described in the 
Inspecting the O-rings section (p.10), before deploying the logger. Do not use excessive force 
when tightening the end cap; hand-tight is quite sufficient, as the seal depends upon the O-
rings, not the end cap tightness.  

TR-1060 loggers 

 

 

 

To open the TR-1060 loggers, turn the logger counter-clockwise from the middle (Warning: 
do NOT try to open the logger from the sensor end, which will break the circuit card). When 
the logger is disassembled, handle only the logger case. The logger case does not unscrew 
completely until the O-ring is clear of its mating surface in the body. This ensures that it will 
not eject at high speed should the interior of the logger become pressurized. Carefully slide 
out the half logger case with the inner assembly and battery holder.  

 

 

 

  

Note:  Do NOT turn the TR-1060 logger from the sensor end, which will 
break the circuit board.  
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Changing the batteries  

For a discussion of battery life expectancy, please refer to Appendix A - Battery lifetime 
calculation on page 52. 

RBR data loggers are powered by 2/3A size 3V lithium cells. These are standard camera 
batteries, and may be obtained from retail photographic or hardware outlets (see the 
following chart for model numbers). 

Energizer Kodak IEC Procell Duracell Rayovac Panasonic Varta 

EL123A K123LA CR17345 PL123A DL123A RL123A CR123A CR123A 

Before changing the batteries, ensure that the logger is not sampling and leave it idle for at 
least one minute after disconnecting it from the computer. This will ensure that it has 
entered its standby state and its operation will not be disturbed by removing the old 
batteries.  

 

loggers 

To remove the batteries, first open the logger. The batteries are held 
within their casing by the force of a single spring.  Press firmly upon 
the negative end of the battery furthest from the spring and pull it out 
of the casing.  

 

XR loggers 

To remove the batteries, first open the logger and remove the battery carousel. The 
batteries can easily be slid out of the carousel.  

When inserting new batteries, ensure that they are correctly oriented; the yellow “+” 
markings at the end of the battery carousel indicate the direction towards which the positive 
terminal of the battery should be placed.  The logger will not work if the batteries have been 
inserted improperly. 

Important: RBR data loggers do not have a backup battery.  If the 
logger has entered its standby state, the clock can run for 
approximately two minutes without batteries; however, it will almost 
certainly lose a significant amount of time.  It is also quite possible 
that the clock will reset.  We strongly suggest that the logger be 
programmed after the batteries have been changed. 

1050 and 2050 series 
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TR-1060 loggers 

To remove the battery, first open the logger. The battery is held within 
its casing by the force of a single spring.  Press firmly upon the 
negative end of the battery farthest from the spring and pull it out of 
the casing.  

When inserting a new battery, ensure that it is correctly oriented. The 
positive terminal of the battery should be placed toward the spring; the 
“+” marking on the bottom of the battery carousel indicates this 
direction.  The logger will not work if the batteries have been inserted 
improperly. 

 

Communicating with the logger  
1050/2050 and XR series loggers 

Using the internal data port 

To establish a link between the logger and a computer, open the 
logger and locate the RJ-11 jack mounted at the end opposite the 
sensor(s). The supplied RS232 cable has two sizes of plugs.  The 
narrower plug goes into the logger. The other plug fits into the serial 
port adapter, which then should be plugged into a 9 pin serial port on 
your computer.  

 

If your computer does not have an available serial port, but does have 
a USB port, a serial to USB adapter may be used.  Simply fit the serial 
connector into the serial to USB adapter and plug the adapter into the 
USB port on the computer. 

Please note that the USB adapter’s drivers must be installed before it 
will work.   



N

Using an underwater connector 

Some loggers are equipped with an Impulse MSSJ series underwater connector.  This 
connector makes it possible to program and retrieve data from the logger while it is 
underwater.  Please refer to the Real-time display section of the manual on page 18 for 
more information about live data collection.   

An optional RS485 interface allows for use of cables over 1km long.   

To establish a connection, press the cable plug into the bulkhead receptacle and tighten the 
stainless steel connector.  Please see the note below for precautions regarding the O-rings.  
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-ring specifications may be found in Appendix B on page 5
Note: 

The seal for the underwater connection depends upon two O-
rings: one is attached to the connector and the other to the 
bulkhead.  There are two common difficulties relating to these O-
rings: 

1. If the O-ring on the plug is not well greased, then the 
alignment recess can cut the O-ring.  Greasing the O-ring 
before connecting the plug to the socket will prevent this 
from happening. 

2. The O-ring at the bottom of the receptacle is easily lost.  It 
is specially made for Impulse and has a non-standard 
size.  Replacements may be obtained, but the cost is 
nearly five times that of a standard O-ring of similar size.  
Do not lose this O-ring.  If you do, contact RBR for a 
replacement.   
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ecent loggers are equipped with IE55 connectors and the following guidelines are 
rovided: 

ubricate mating surfaces with 3M Silicone Spray or equivalent. DO NOT GREASE. 
onnectors must be lubricated on a regular basis.  

E55-1200 contact surfaces must be dry prior to mating.  

ubricate O-rings with Dow Corning #111 Valve Lubricant or equivalent.  

eep O-ring grooves clean and avoid cuts and nicks in the O-ring. Replace O-rings when 
e-mounting connectors.  

void contact with solvents.  

void sharp bends at cable entry to connector.  

lastomers can be seriously degraded if exposed to direct sunlight or high ozone levels for 
xtended periods of time.  
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TR-1060 loggers 

To establish a link between the logger and a computer, open the 
logger and locate the data port mounted in the middle part of the inner 
assembly adjacent to the battery holder. The supplied RS232 cable 
has two sizes of plugs.  The narrower plug goes into the logger 
connector. The other plug fits into the 9-pin serial port on your 
computer.  

If your computer does not have an available serial port, but does have a USB port, a serial 
to USB adapter may be used.  Simply fit the serial connector end into the serial to USB 
adapter and plug the adapter into the USB port on the computer. 

Please note that the USB adapter’s drivers must be installed before it will work.  

Deployment  
Once you have ensured that the batteries are fresh, inspected the O-rings and programmed 
the logger (see Configuration and Scheduling operation on page 6 for programming 
instructions), the instrument is ready to be deployed.  There are three precautions you 
should take to avoid damaging the logger: 

1. Heed the maximum pressure rating.  All RBR loggers with pressure sensors are 
individually rated to a maximum depth/pressure.  This is indicated by the label which is 
placed on the logger’s sensor end cap.  Loggers which do not have a pressure sensor do 
not have this label, but are limited by the maximum depth/pressure rating of either the 
logger housing itself or of the sensors. 

2. Avoid physical stress to the logger.  Any type of clamp or bracket which introduces 
pointed stress to the logger body is not recommended for use in logger mooring, mounting, 
and/or other deployment.  Stress due to improper mounting may cause the logger to leak, 
resulting in the loss of valuable data or permanent damage to the electronics.  RBR can 
provide proper mooring and mounting clamps suited to your specific application. 

3. Use desiccant when necessary.  If the logger is closed up in a hotter, more humid 
environment than the deployment environment, internal condensation can result.  Since 
condensation may cause the circuitry to malfunction, it is advised under these 
circumstances that you contact RBR for an application specific solution; this may involve the 
installation of desiccant prior to deployment. 
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Maintenance and repairs  
Support kits 

To simplify maintenance of your data logger, RBR sells Support kits with enough O-rings, 
and silicone grease for 5 deployments.  Please contact RBR for more information or to 
place an order. 

O-rings 

The single most important item of maintenance on any RBR submersible data logger is care 
of the O-rings. Any kind of water leak can damage the circuitry beyond repair and cause 
complete data loss.  Every logger’s seal depends upon its O-rings, not the end cap 
tightness.  Proper O-ring maintenance, therefore, is crucial.   

Please see Appendix B on page 53 for O-ring specifications for each logger. 

Inspecting O-rings 

 

 

 

 

 

O-rings must be undamaged and the mating surfaces free from particles of grit, hair or small 
scratches in order to preserve a seal. Before deploying the logger, carefully inspect the O-
rings that are required to maintain a seal.  1050/2050 series loggers depend upon one O-
ring in the end cap.  The plastic XR series of loggers have one O-ring for each end cap and 
two for each detachable sensor.  Titanium versions of the XR series loggers have a backup 
ring in each end cap as well.  TR-1060 loggers have one O-ring seated in the middle part of 
the logger case. 

Give particular attention to the following areas: 

• The surface of the O-ring itself 

O-ring on 1050/2050 and XR loggers O-ring on TR-1060 loggers 

Important:  O-rings may lose elasticity over time due to pressure, 
even when the logger is not deployed. We strongly suggest that 
the O-rings be replaced regularly, e.g. before every deployment, 
or after change of batteries, or at least once a year. 
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• The mating surface on the inside of the case between the threads and the open end 

• The inner surfaces of the groove in the end cap where the O-ring sits 

• The mating surfaces for each removable sensor 

• The underwater connector for external power or data transfer (if used) 

Any dirt present should be removed by wiping thoroughly with a soft, 
lint-free cloth. When cleaning, never use any material or tool which 
could scratch the O-ring or any of its mating surfaces. If any dirt is 
present in the O-ring groove, then the O-ring should be removed as 
described below to allow thorough cleaning of the groove. If an O-ring 
needs to be removed for any reason, it should be replaced.  

If the O-ring is scratched, cut, distorted, perished or defective in any other 
way it must be replaced. If any of the surfaces of the O-ring groove are 
scratched, pitted or otherwise damaged, the logger may need to be 
returned to RBR for refurbishment: please contact us for advice. 

Replacing an O-ring 

1) Lever the O-ring from its groove. Use a soft plastic or wood tool; do not use a metal 
screwdriver or any other tool which may scratch the surfaces of the O-ring groove: doing so will 
probably render the end cap useless. Slide the O-ring out of its groove and off the logger.  The 
O-ring may need to stretch quite a bit as it is pushed off; this requires some effort but can be 
done by hand. 

2) Thoroughly clean the O-ring groove, taking great care not to scratch or damage it in 
any way. Inspect it carefully, and contact us for advice if it appears damaged. Apply a light 
film of silicone grease to all three inside surfaces of the groove, being careful not to trap any 
dirt, hairs or lint.  

3) Select the proper O-ring (consult Appendix B on page 53 for O-ring sizes) and make 
sure it is not damaged. Lubricate it with a very light film of silicone grease to ease its 
installation.  

4) Install the new O-ring by pushing it into place and popping it into its groove. The O-
ring may need to stretch quite a bit as it is pushed on; this requires some effort but can be 
done by hand. 

5) When the new O-ring is in place, inspect it once more for scratches and dirt, and 
wipe away any silicone grease deposited on the end cap. 

Most experienced users of oceanographic equipment replace all O-rings before every 
deployment as a matter or routine. The cost of an O-ring is negligible compared with the 
cost of the instrument and its deployment.  Routine replacement of O-rings, therefore, is 
cheap insurance. 
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Drying agent 

 

 

 

 

 

If the logger is closed up in a hotter, more humid environment than the deployment 
environment and then plunged into cold water, internal condensation can result. Since 
condensation may cause the circuitry to malfunction, it is advised in such circumstances 
that, after the logger is set up and before it is closed for deployment, a small pack of 
desiccant be placed on the battery side of the circuit board above the battery mount. 

A desiccant plastic “pocket” should be installed before adding a desi-pack. The pocket is an 
L-shaped piece of plastic designed to keep any moisture absorbed by the desi-pack off the 
electronics.   

If your application requires desiccant, please contact RBR for more information. 

Repairs 

We support all instruments and software that we manufacture. First line support is always 
available by phone, fax or e-mail.  Please contact us immediately if you are experiencing 
problems with your RBR product.  It is very important to contact us before returning your 
instrument, as some difficulties can be easily solved on-site by the user.  Please have the 
model and serial number of the unit handy when you contact us. 

There are no user-repairable parts of the logger.  Any attempt at repair, whether successful 
or not, without prior authorization from RBR Ltd. will void the warranty.   

If it is necessary to return the product to RBR for an upgrade, repair, or calibration; please 
review the detailed shipping information on our website before returning the unit. 

Calibration 

We recommend that you verify the calibration of your data logger before any critical deployment, 
periodically once a year, or if you suspect the calibration to be out of specifications.  Discuss 
your calibration needs with RBR.  In some cases, you will be recommended to return the 
instrument to RBR to have it checked and re-calibrated.  Please contact us for our current 
calibration fees  

TR-1060 loggers 1050 & 2050 series XR series 
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Appendix A – Battery life calculation 
When to replace the batteries 
Compared to the cost of deployment, the cost of a new set of batteries is close to 
negligible.  We highly recommend that the batteries be replaced before every 
deployment unless there is no doubt that they have sufficient capacity. 
Battery voltage does not decrease linearly and is therefore not an accurate indicator of 
battery capacity.  However, if the logger software indicates that the batteries have less 
than 12V remaining (6V for single channel loggers), the batteries should be replaced. 

 

 

Predicting battery life 
Battery life prediction is a complicated issue.  In RBR loggers, battery life is a strong 
function of the type of logger, the type and number of sensors attached, the sampling 
scheme (sampling period and the use of: thresholding, real-time data collection and 
averaging), and the temperature of the water during the deployment.  Manufacturers’ 
data for the batteries do not provide information that can be directly related to way the 
batteries are used in RBR Loggers. 
The Ruskin Software calculates the expected battery usage (in mA Hours - mAh) for the 
logger during setup, see Ruskin User Guide.  The nominal capacity of the batteries is 
1300mAh at room temperature.  The software will warn the user if the expected battery 
usage for a particular deployment scenario is above 1000mAh.  The software will not 
prevent a logger from being started even if a warning is given.  In tests at RBR Ltd. of 
multiple examples of various brands of batteries at 6°C, all examples were able to 
provide the threshold capacity of 1000mAh.  The user should view these predictions 
and further de-rate the batteries if the expected deployment is in cold water.  The 
battery usage estimate is stored as part of the log files and may be used after 
deployment to enable the user to obtain a characterization of how a particular logger 
performs. 
RBR continues to characterize battery life in its loggers and will continue to improve the 
battery life calculator in future versions of the Ruskin Software. 
Battery life will be reduced if the RS485 serial transmission protocol is employed.  The 
consumption for the RS485 driver is defined as 2.5mA nominal.  Hence for every hour 
of deployment, 2.5mAh must be added to the battery drain figures. 
 

When in doubt, replace the batteries. 



Appendix B – O-ring specifications 
 
Each 1050 or 2050 series logger has one user replaceable O-ring located above the 
thread of its end cap.  Titanium versions also have a backup ring in the same groove. 
XR series loggers have one user replaceable O-ring located in each end cap above the 
thread.  Titanium versions also have a backup ring with each O-ring in the same groove. 
TR-1060 loggers have one O-ring seated in the middle part of the logger case. 
Important:  We strongly suggest that the O-rings be replaced regularly, e.g. 
before every deployment, or after change of batteries, or at least once a year. 
 
1050 and 2050 series loggers - Plastic 

End cap O-ring: #2-214 N70 
1050 and 2050 series loggers - Titanium 

End cap O-ring: #2-214 N70 
Backup ring: #8-214 N90 

XR Series - Plastic 
End cap O-rings:  #2-225 N70 

XR Series - Titanium 
End cap O-rings:  #2-225 N70 
Backup rings:  #8-225 N90 

TR-1060 loggers - Plastic 
O-ring:  #2-018 N70 

Impulse MSSJ underwater connector 
Bulkhead #5-058 N70 (non-standard, 
 contact RBR for replacements) 
Plug #2-013 N70 
See page 49 for more details 

Impulse IEE55 underwater connector 
No O-rings are required 
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Appendix C – Event and Error Stamps 
 
The following is a list of event/error stamps that may be displayed in the data set. 
TIM - Time synchronization event 
STP - Stop sampling event 
GAN - Gain change event 
CHG - Change event (system restart where logger clock is no longer valid) 
WRM - Warm startup event (clock and programmed parameters are valid/unharmed) 
REC - Recovery event (problem with Real time clock. Logger attempts to fix the time but 
it may not be accurate) 
BST - Burst event (for waves) 
RTC - Real Time Clock change event 
LUK - Cool startup event (some programmed parameters may not be valid) 
CLD - Cold startup (startup from a complete power down) 
TTY - Communication problem event 
SER - Serial error (XR 620/420, problem communicating between micro computer and 
sensor card) 
 

Below is a description of all the different event stamp types xxx which could be 
encountered.  Some of these are quite common, while others indicate very rare fault 
conditions.  Some may also occur together in various combinations, with no sample 
data between them. 
 

TIM is used to ensure timing synchronization, whenever there is a possibility that the 
actual date/time of a sample according to the logger’s internal calendar/clock does not 
match what is expected in the normal sampling sequence. 
 

STP is used to indicate that a command to stop sampling occurred. 
 
 
GAN is used to indicate that a sensor has changed its gain setting – typically occurs 
with auto-ranging fluorometers and turbidity sensors. 
 

CHG is used to indicate a system restart, in which all programmed parameters are 
valid, but the date/time in the internal real time clock was not.  This may typically occur 
after interruption of power to the logger; for example, if the batteries are changed. 
 

WRM indicates a system restart, in which all programmed parameters are valid, and so 
is the date/time in the internal real time clock.  This may occur in response to some 
electrical disturbance which resets the logger’s CPU, but does not affect it otherwise; 
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this can include very brief interruption of battery power due to mechanical shock or 
vibration. 
 

REC may accompany a CHG timestamp if the logger’s non-volatile status indicates that 
it should be sampling.  The date/time in the logger’s real time clock is corrupted, but the 
logger makes an attempt to reconstruct a valid setting as nearly as possible, using data 
already recorded in the memory.  The result will not be exactly correct, but at least 
allows the logger to continue collecting data, while the timestamp alerts the user to a 
possible problem with the sample times.  It may later be possible to reconstruct the true 
sample times by correlating the data with an external influence at a known time 
 
There is also an event stamp which routinely appears in user data, but only in a TWR 
data logger which is used for recording wave bursts. 
 

BST indicates the start of a recorded wave burst in a TWR data logger.  Wave bursts 
are a special case, with some differences when compared to other stored data.  Each 
individual reading is still stored as a 3-byte, 24-bit number, with the most significant byte 
first.  However, there is not a reading from every channel in the logger within the burst; 
a burst contains only readings from the pressure channel.  The number of readings 
present will be the wave burst length.  The time between the readings within the burst is 
determined by the wave burst sampling rate. 
 
The wave burst is usually followed by a timestamp to ensure synchronization of the 
following data.  This will typically be for tidal averages, in which the stored data reverts 
to its normal format of one reading per channel, until another wave burst occurs. 
 
The remaining timestamp types are much less common, and may be associated with 
one of a number of rare faults or unusual situations. 
 

RTC shows that the RTC date/time was changed, in a way which may affect the sample 
time sequence.  It is always accompanied by TIM timestamps showing the date/time 
both before and after the change was made, and a synchronizing timestamp with the 
sample data if necessary.  This is not commonly seen, because RBR software does not 
permit date/time changes while the logger is sampling. 
 

LUK indicates a system restart, in which the internal real time clock contained a valid 
date/time, but one or more of the programmed parameters was not valid.  Non-volatile 
storage of the programmed parameters is normally very robust, and this is not a 
common occurrence. 
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CLD indicates a complete system restart; neither the internal real time clock setting nor 
the programmed parameter values were valid.  This usually occurs only in instruments 
which are brand new or which have been reprogrammed or reconfigured, and is not 
normally seen outside the RBR factory. 
 

TTY indicates a serious failure of communication with the host, in which the logger was 
unable to send data over the serial connection because of an internal problem, although 
it may be able to recover later.  This is very rare. 
 

SER can occur only in an XR-420 or XR-620, and indicates a serious failure of 
communication between the CPU and one or more of the internal sensor modules.  
Again, the logger may be able to recover subsequently, and the fault is very rare. 
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